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A. Experimental Site and Plant Material 

  

The investigation was conducted within the saran-screen greenhouse facility at the Department of 

Horticulture and Landscape Architecture, College of Agriculture and Marshes, University of Dhi Qar, during 

the 2025–2026 agricultural season. The experimental material consisted of uniform, healthy 1.5-year-old 

China rose (Hibiscus rosa-sinensis L.) seedlings evaluated to determine their response to varied irrigation 

intervals and foliar melatonin treatments.  

 

B. Experimental Treatments and Design 
 

The experiment was implemented as a two-factor completely randomized block design (RCBD) with three 

replications (3x3x3 = 27 experimental units). 

Factor 1: Drought Stress (D): Placed in the main plots, comprising three irrigation intervals: 

1. D1: Continuous daily irrigation (control). 

2. D2: Irrigation every 4 days (moderate drought). 

3. D3: Irrigation every 7 days (severe drought). 

Factor 2: Melatonin Concentrations (M): Comprising three foliar spray doses: 

1. M1: 0 mg L⁻¹ (solvent control). 

2. M2: 50 mg L⁻¹. 

3. M3: 100 mg L⁻¹. 

B.1. Preparation of Melatonin Solutions 

To prepare the 50 mg L⁻¹ solution, 0.05 g of pure melatonin powder was completely dissolved in 2–

3 mL of absolute ethanol (100%), and the volume was adjusted to 1 L using deionized distilled water under 

constant magnetic stirring to ensure homogeneity. For the 100 mg L⁻¹ solution, 0.1 g of melatonin powder 

was similarly dissolved in 2–3 mL of absolute ethanol and diluted to 1 L with distilled water. The 0 mg L⁻¹ 

control treatment was prepared by adding 2–3 mL of absolute ethanol to 1 L of distilled water without 

melatonin to eliminate potential solvent artifacts (solvent control). A non-ionic surfactant, Tween 20 

(0.05%v/v), was integrated into all formulations to minimize droplet surface tension and maximize foliar 

wetting efficiency.. 

B.2. Timeline and Crop Management 

• October 1, 2025: Seedlings were carefully transplanted into larger plastic pots filled with a uniform 

substrate mixture of local soil and peat moss (2:1v/v). Following transplanting, pots were irrigated 

to field capacity and maintained under greenhouse conditions for 24 hours to stabilize. 

• October 2025 – March 2026: Seedlings were arranged randomly according to the RCBD layout and 

grown under standard cultural practices to achieve full acclimatization and establishment within the 

growth medium. 

• April 1, 2026 – May 1, 2026: The irrigation treatments (D1, D2, D3) were strictly enforced to 

coincide with rising ambient temperatures, maximizing natural evaporative demand. 
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• Foliar Spray Schedule: Melatonin treatments were applied via a calibrated manual pressure sprayer 

until absolute foliar runoff. Sprays were administered at 10-day intervals across three sequential 

dates: 

 

• First Application: April 10, 2026 

• Second Application: April 20, 2026 

• Third Application: April 30, 2026 

• Irrigation volumes were strictly tailored to replenish moisture levels up to field capacity, and all pots 

featured basal drainage perforations to prevent waterlogging and salt accumulation. 

B.3 Sampling and Tissue Preparation 

Destructive and non-destructive measurements were conducted at the termination of the trial on May 1, 2026, 

capturing the cumulative response to the treatments. Leaf samples intended for biochemical extraction were 

harvested during early morning hours (06:00−08:00 AM) to preserve cellular turgidity and prevent 

biochemical degradation. Leaves were gently rinsed with deionized water to eliminate dust and surface 

residues prior to chlorophyll extraction. 

C. Quantitative and Qualitative Traits 

1. Plant Height (cm): Plant height was measured linearly from the soil-root crown junction to the apical 

meristem tip using a calibrated metric tape. 

2. Stem Diameter (mm): Stem diameter was recorded utilizing a high-precision digital vernier caliper at a 

fixed point 2 cm above the soil substrate level to ensure accuracy in tracking radial stem development. 

3. Leaf Count (leaves plant⁻¹) : The total number of fully expanded, functional leaves per seedling was 

manually counted. Emergent, unexpanded apical leaves and fully senesced leaves were excluded. 

4. Total Leaf Area (cm2):Leaf area was determined via digital image processing using ImageJ software 

(v1.54) following a modified protocol based on Sadik et al. (2011). Two fully expanded, non-damaged leaves 

were selected per plant. Individual leaves were placed flat on a non-reflective, matte-white background panel 

alongside a standard metric calibration scale. Images were captured using a high-resolution mobile camera 

positioned at a fixed perpendicular distance (40 cm) under uniform diffuse illumination. The images were 

loaded into ImageJ, calibrated to spatial dimensions (pixels mm-1), thresholded, and the total surface area 

was computed automatically in square centimeters (cm2). 

5. Total Chlorophyll Content (mg 100g−1 Fresh Weight): Total chlorophyll extraction and quantification 

were performed according to the spectrophotometric method of Goodwin (1976). Fresh leaf tissue (0.5 g)  

was finely homogenized in a porcelain mortar with 10 mL of 80% aqueous acetone. The homogenate was 

transferred to light-shielded centrifuge tubes wrapped in aluminum foil to prevent photo-oxidation and 

centrifuged at 5000 rpm for 15 minutes. The supernatant was decanted, and optical densities were recorded 

at wavelengths of 663 nm (A663) and 645 nm (A645) using a UV-1700 spectrophotometer. Total chlorophyll 

concentration was computed via the following empirical formula: 

𝐓𝐨𝐭𝐚𝐥 𝐂𝐡𝐥𝐨𝐫𝐨𝐩𝐡𝐲𝐥𝐥 (𝐦𝐠 𝟏𝟎𝟎𝐠 − 𝟏 ) =
[𝟐𝟎. 𝟐 𝒙 𝑨𝟔𝟒𝟓 +  𝟖. 𝟐 𝒙𝑨𝟔𝟔𝟑] 𝒙 𝑽

𝑾  𝒙𝟏𝟎𝟎𝟎
 𝒙𝟏𝟎𝟎 

Where: 

• A: Optical density at the specified wavelength. 

• V: Final volume of the acetone extract (10 mL). 

• W: Fresh leaf weight (0.5 g). 

6. Digital Phenotyping for Leaf Chlorosis, Necrosis, and Healthy Green Areas (%) 

To quantify leaf health non-destructively and eliminate human bias, a digital phenotyping methodology 

was integrated within ImageJ using Hue-Saturation-Value (HSV) color-space segmentation. Digital images 

acquired under identical lighting and spatial configurations (Section 4) were processed as follows: 
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1. Color Space Conversion: RGB images were converted into the 8-bit HSV color space using the 

Image > Type > HSV Stack function to decouple color information (Hue) from brightness 

variation. 

2. Color Thresholding and Segmentation: The Image > Adjust > Color Threshold menu was used to 

isolate distinct pixel groups based on predefined Hue angle ranges: 

• Healthy Green Tissue Area (Agreen): Segmented within the Hue range of 60∘ to 150∘. 

• Chlorotic/Yellow Tissue Area (Ayellow): Segmented within the Hue range of 35∘ to 59∘. 

• Necrotic/Damaged Tissue Area (Adamage): Segmented within the Hue range of 0∘ to 34∘, 

alongside low brightness values (Value<50) to capture dark brown desiccated regions. 

3. Pixel Area Computation: The Analyze > Measure tool computed the total pixel count for each 

thresholded phase alongside the absolute total leaf area (Atotal). The respective tissue percentages 

were calculated using the following mathematical models: 

1- 𝐇𝐞𝐚𝐥𝐭𝐡𝐲 𝐆𝐫𝐞𝐞𝐧 𝐀𝐫𝐞𝐚 𝐏𝐞𝐫𝐜𝐞𝐧𝐭𝐚𝐠𝐞 (%)  = (
𝑨 𝒈𝒓𝒆𝒆𝒏

𝑨 𝒕𝒐𝒕𝒂𝒍
) 𝒙𝟏𝟎𝟎 

2- 𝐂𝐡𝐥𝐨𝐫𝐨𝐬𝐢𝐬 𝐏𝐞𝐫𝐜𝐞𝐧𝐭𝐚𝐠𝐞 (%) = (
𝑨 𝒚𝒆𝒍𝒍𝒐𝒘

𝑨 𝒕𝒐𝒕𝒂𝒍
) 𝒙𝟏𝟎𝟎 

3-  𝐓𝐢𝐬𝐬𝐮𝐞 𝐍𝐞𝐜𝐫𝐨𝐬𝐢𝐬/ 𝐝𝐚𝐦𝐚𝐠𝐞 𝐏𝐞𝐫𝐜𝐞𝐧𝐭𝐚𝐠𝐞   (%)  = (
𝑨 𝒅𝒂𝒎𝒂𝒈𝒆

𝑨 𝒕𝒐𝒕𝒂𝒍
) 𝒙𝟏𝟎𝟎 

D. Statistical Analysis 

Data were subjected to analysis of variance (ANOVA) using GenStat software (Release 11.1, 2008). 

Treatment means were statistically resolved and separated utilizing the Least Significant Difference (L.S.D.) 

test at a verification probability level of α=0.05 according to Al-Rawi and Khalaf Allah (2000). 

 

3.1 Plant Height (cm) 

Statistical analysis revealed that both primary experimental factors and their binary interactions exerted 

highly significant impacts on plant height (P≤0.05). Extending the irrigation intervals induced a severe, linear 

restriction on seedling elongation (Figure 1A). The grand mean for plant height decreased significantly from 

39.569 cm under daily watering (D1) to 28.271 cm under severe weekly drought (D3). Conversely, 

exogenous melatonin application stimulated stem elongation (Figure 1B); the mean height increased from 

31.662 cm in the control group (M1) to 35.233 cm at the maximum concentration of 100 mg L⁻¹ (M3). 

The dual interaction analysis highlighted distinct variations (Figure 1C). The combination of daily irrigation 

and 100 mg L⁻¹ melatonin (D1 + M3) produced the highest plant height (40.980 cm), whereas the severe 

drought treatment without melatonin (D3 + M1) resulted in the absolute minimum height (26.460 cm). 

Notably, under severe water stress conditions (D3), foliar spraying with 100 mg L⁻¹ melatonin (D3 + M3) 

successfully mitigated the growth restriction, raising plant height significantly to 30.130 cm. 
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Figure (1) The effect of spraying melatonin on rose seedlings under the influence of drought stress 

 in the trait of Plant Height (cm) 

2. Leaf Count (leaves plant⁻¹) 

Drought stress and melatonin treatments significantly modified leaf production per seedling (P≤0.05). Severe 

water deficit provoked a major decline in leaf retention and emergence (Figure 2A), reducing the mean leaf 

count from 21.78 leaves plant⁻¹ under daily irrigation (D1) to 10.78 leaves plant⁻¹ under weekly irrigation 

(D3). Conversely, foliar treatment with melatonin significantly promoted leaf production and minimized 

abscission (Figure 2B), with the mean leaf count rising from 14.22 leaves (M1) to 18.00 leaves under 100 

mg L⁻¹ melatonin (M3). 

Regarding interactive effects (Figure 2C), the D1 + M3 combination optimized leaf count at 23.00 leaves 

plant⁻¹, while the D3 + M1 treatment recorded the lowest value (8.00 leaves plant⁻¹). However, the 

application of 100 mg L⁻¹ melatonin under severe drought conditions (D3 + M3) restored leaf production to 

13.00 leaves plant⁻¹. 
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Figure (2) The effect of spraying melatonin on rose seedlings under the influence of drought stress 

 in the trait of number of leaves (plant leaf-1) 

3.Total Leaf Area (cm2) 

Leaf expansion was strictly regulated by the experimental treatments (P≤0.05). Data compiled in Table 1 

indicate that decreasing irrigation frequency resulted in a significant reduction in total leaf area, which 

declined from 258.29 cm2 (D1) to 133.63 cm2 (D3). Melatonin application at 100 mg L⁻¹ (M3) countered 

this trend, increasing the mean leaf area to 213.96 cm2 compared to 172.83 cm2 in the untreated control 

(M1). 

The interaction matrix showed that the maximum leaf area was achieved under the D1 + M3 combination 

(271.36 cm2), while the minimum area occurred under the D3 + M1 treatment (104.19 cm2). Exogenous 

application of 100 mg L⁻¹ melatonin under weekly drought (D3 + M3) successfully expanded the functional 

leaf area to 161.64 cm2. 

Table 1: Effect of melatonin foliar spray on the leaf area (cm2) of China rose seedlings under drought 

stress. 

Irrigation Regimes 
Melatonin (mg L⁻¹) 

Irrigation Mean 
0 (mg L⁻¹)  50 (mg L⁻¹) 100  (mg L⁻¹) 

Daily (D1) 246.35 257.15 271.36 258.29 

4 Days (D2) 167.94 189.81 208.87 188.87 

Weekly (D3) 104.19 135.04 161.64 133.63 

Melatonin Mean 172.83 194.00 213.96  

L.S.D. 0.05 
Melatonin Interaction Irrigation 

0.814 1.409 0.814 
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4.Stem Diameter (mm): 

Stem radial growth was significantly limited by water deficit and enhanced by melatonin treatments (P≤ 

0.05). According to Table 2, increasing the irrigation interval reduced the mean stem diameter from 5.427 

mm under the control regime (D1) to 4.383 mm under weekly stress (D3). Conversely, melatonin applications 

induced a gradual increase in stem diameter, peaking at 4.996 mm in the M3 treatment compared to 4.670 

mm in the M1 control. 

The interaction analysis indicated that the D1 + M3 combination yielded the thickest stem diameter (5.540 

mm), while the D3 + M1 treatment resulted in the lowest value (4.216 mm). Melatonin supplementation at 

100 mg L⁻¹ under weekly irrigation stress (D3 + M3) significantly improved radial stem expansion, raising 

it to 4.550 mm. 

Table 2: Effect of melatonin foliar spray on the stem diameter (mm) of China rose seedlings under 

drought stress. 

Irrigation Regimes 
Melatonin (mg L⁻¹) 

Irrigation Mean 
0 (mg L⁻¹) 0 (mg L⁻¹) 0 (mg L⁻¹) 

Daily (D1) 5.30 5.43 5.54 5.42 

4 Days (D2) 4.48 4.69 4.90 4.69 

Weekly (D3) 4.21 4.38 4.55 4.38 

Melatonin Mean 4.6700 4.8367 4.9967  

L.S.D. 0.05 Melatonin Interaction  Irrigation  

 0.021 0.03 0.021 

 

5. Total Chlorophyll Content (mg 100g−1 Fresh Weight): Total chlorophyll concentrations dropped 

sharply by over 46.5% under severe weekly drought (D3), falling from a control mean of 91.28 mg 100g−1 

FW to 48.80 mg 100g−1 FW (Table 3). Melatonin treatments provided significant protection against pigment 

degradation (P≤ 0.05); the grand mean for total chlorophyll increased from 62.45 mg 100g−1 FW (M1) to 

79.43 mg 100g−1 FW in the 100 mg L⁻¹ group (M3).The interaction matrix confirmed that the D1 + M3 

combination achieved the maximum chlorophyll concentration (96.10 mg 100g−1 FW), while the un-

remediated severe drought group (D3 + M1) fell to a minimum of 35.73 mg 100g−1 FW  . However, applying 

100 mg L⁻¹ melatonin to weekly stressed seedlings (D3 + M3) significantly maintained chlorophyll levels at 

61.30 mg 100g−1 FW . 

Table 3: Effect of melatonin foliar spray on total leaf chlorophyll mg 100g−1 FW) of China rose 

seedlings under drought stress. 

Irrigation Regimes 
Melatonin (mg L⁻¹) 

Irrigation Mean 
0 (mg L⁻¹) 0 (mg L⁻¹) 0 (mg L⁻¹) 

Daily (D1) 86.95 90.77 96.10 91.28 

4 Days (D2) 64.67 74.65 80.87 73.40 

Weekly (D3) 35.73 49.38 61.30 48.80 

Melatonin Mean 62.45 71.60 79.43  

L.S.D. 0.05 
Irrigation Interaction Melatonin 

3.42 5.92 3.42 

6. Digital Phenotypic Percentages: Healthy Green, Chlorosis, and Necrosis (%)  
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The relative percentages of green, chlorotic, and damaged tissue reflect the physiological balance between 

cell viability and programmed senescence under environmental stress (Figure 3). Under daily irrigation (D1), 

seedlings maintained high health indices; the healthy green percentage stabilized between 96% and 97%, 

chlorosis remaining exceptionally low (2.37%−2.94%), and tissue necrosis dropping below 1.5%. These 

values indicate stable hydraulic conditions and operational balance in carbon-fixation pathways. Withholding 

water for four days without melatonin intervention (D2 + M1) significantly reduced the healthy green area 

to 72%, while increasing the chlorosis index to 18.25% and structural leaf damage to 9.72%. This decline 

worsened under severe weekly drought lacking melatonin (D3 + M1); the healthy green area dropped to a 

study minimum of 45%, chlorosis rose to 31.90%, and cellular tissue necrosis expanded substantially to 

23.28%. Foliar melatonin application significantly mitigated these symptoms, indicating a powerful 

protective mechanism. In the moderate drought group, 100 mg L⁻¹ melatonin (D2 + M3) reduced tissue 

necrosis from 9.72% to 5.91%, limited chlorosis to 10.96%, and restored the healthy green area to 83%. 

Under severe weekly drought, the 100 mg L⁻¹ treatment (D3 + M3) rescued leaf tissues from severe 

degradation, maintaining the healthy green canopy area at 67%, restricting chlorosis to 20.44%, and checking 

tissue necrosis and leaf-margin scorch at 12.70% compared to 23.28% in the untreated group. 

 

 

Discussion 

The systematic reduction in morphological growth metrics (height, leaf number, leaf area, and stem 

diameter) and biochemical profiles under drought conditions is directly linked to a reduction in water 

potential within plant cells, causing a subsequent loss of intracellular turgor pressure. Nop-optimal turgor 

pressure acts as a severe biophysical constraint that prevents cell wall expansion and longitudinal stretching, 

which are required for height and lateral stem growth. Furthermore, water deficit prompts stomatal closure 

to limit transpirational water loss, which reduces intercellular CO2 availability, decreases photosynthesis, 
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and suppresses dry matter accumulation (Farooq et al., 2012).The marked increase in leaf chlorosis and tissue 

damage under drought stress (Figure 3) can be explained by the bio-chemical degradation of chlorophyll 

molecules triggered by high chlorophyllase activity and the accumulation of Reactive Oxygen Species 

(ROS). These free radicals induce severe lipid peroxidation of cellular membranes, causing cellular leakage 

and desiccation (Sharma et al., 2012). Accelerated leaf abscission and reduced leaf counts serve as an 

adaptive escape mechanism mediated by endogenous abscisic acid (ABA) accumulation to lower the total 

transpirational surface area of the plant (Kapoor et al., 2020).Exogenous melatonin application induced 

substantial recovery across all evaluated growth parameters, most notably preserving total chlorophyll 

content and increasing the green leaf area percentage. This physiological promotion highlights melatonin's 

function as an auxin-like growth regulator, which activates plasma membrane, ATPases to enhance cell wall 

extensibility and stimulate cellular elongation (Arnao and Hernández-Ruiz, 2019). Additionally, melatonin 

expanded total leaf surface area and prolonged leaf retention by delaying stress-induced senescence.As a 

primary amphiphilic antioxidant, melatonin directly neutralizes ROS while upregulating the enzymatic 

activities of SOD, CAT, and POD, thereby protecting thylakoid membranes from oxidative damage under 

drought (Reiter et al., 2015). This protective shield ensures photosystem operational stability, allowing 

continuous carbohydrate synthesis and allocation to active sinks.The binary interaction data proved that 

melatonin treatment under drought stress functions as a highly effective osmoregulator. It triggers the cellular 

accumulation of compatible osmolytes such as proline and total soluble sugars, allowing cells to maintain a 

positive turgor pressure under reduced soil moisture conditions (Wang et al., 2013). Melatonin also reduces 

ion leakage by stabilizing cellular membranes. Moreover, it regulates the gene expression of water-transport 

proteins (aquaporins), optimizing hydraulic conductivity from root systems to the canopy. This metabolic 

reprogramming establishes melatonin as a crucial signaling molecule that restructures plant physiological 

pathways to overcome harsh environmental conditions (Li et al., 2019). 
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